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Data Collection Overview 
 
 
Our primary objective is to provide a facility for statewide data collection, processing 
and information dissemination to the project team, coalition members and interested 
parties.   
 
In anticipation of serving communities within eleven (11) regional study areas, the 
challenge is to implement an approach that will maximize the efficiency and accuracy of 
collecting significant amounts of data from numerous locations from hundreds of 
participants.   To this end, a resources “tool kit” has been put in place to address the 
needs of all parties associated with the Texas State Incentive Program (TSIP).  
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Texas State Incentive Program (TSIP) 
 

TSIP Web Site 
 
How to access: 
 
The TSIP web site may be accessed from any computer on the World Wide Web at the 
web address:   www.txsip.org .   
 
 
Available resources: 
 
The internet web site containing evaluation findings will allow community-based 
organizations to review and/or download reports as well as request information or 
submit questions or suggestions.  Summaries and detail reports will be available in 
common formats such as Adobe Acrobat Reader PDF.  The web site will also serve as a 
direct and immediate means of communication to TCADA.  Statewide aggregate and 
local findings will be posted as well as the status of evaluation efforts.  This on-line 
evaluation tool kit will significantly facilitate collaboration and communication between 
TCADA, the statewide evaluation team, and local evaluators.  It will further ensure 
effective local level evaluation.  As data are received they will be compiled and will 
undergo consistency checking to assure accuracy.  An ongoing tally of data received, 
analysis performed, and preliminary findings will be posted on the web site on a regular 
basis.       
 
The web site will serve as the central source for field personnel to acquire all the 
necessary forms, reports and notices required during the term of the project.  
Informational areas would consist of bulletin board announcements, a project calendar, 
reports and links to other relevant web sites.  The web site also includes a “web Tools” 
area for accessing forms and file downloads.   
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Online data entry: 
 
 
With the exception of the Texas Strategies for Success (TSFS) and other evaluation 
forms, project update forms and requests for information, would be Internet based, that 
is to say that the individual would select the desired form and a copy would immediately 
be displayed for their use.  All forms are designed in a “fill in the blanks” mode, to 
include field integrity checks (i.e. numeric only field, range checks, etc.) radio buttons 
and drop down lists.   
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Off-line Data Entry Overview: 
 
There are several advantages to off-line data entry.  Lengthy evaluation interviews may 
require the presence of the program participant or reference to documentation that may 
not be readily accessible during an on-line internet session.   Interrupted or incomplete 
interviews are not normally accepted by on-line data entry systems, whereas in an off-
line environment data may be entered as it becomes available.  Also, the database of 
previously entered records may be queried and edited if needed. 
 
As mentioned earlier, forms will be designed using OmniForm software which is 
specifically developed for creating, filling and managing electronic forms.  AIS will use 
the developer’s version and take full advantage of program capabilities.  However, field 
evaluators will be provided the “FormFiller” version of the software to prevent any 
modification of the form or field edits.   
 
The Texas Strategies for Success (SFS) will be completed off-line.  In these 
circumstances, a CD-ROM with dedicated FormFiller software and an electronic 
version of the survey form will be made available to all evaluators to allow for off-line 
data entry.   Upon completion, the resultant database will be submitted as an email 
attachment to the TSIP data manager.  The diagram below depicts the two data 
collection approaches. 
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Texas Strategies for Success (TSFS): 
 
The TSFS is the primary instrument used to capture individual participant data. The 
resultant database will undergo a thorough analysis to determine the overall 
effectiveness of each program. 
 
The following is a sample of the cover page and page 1 of the of the form: 
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Data entry software – Overview: 
 
The OmniForm Filler will make it easy to fill and manage your electronic forms such as 
the Texas Strategies for Success (TSFS) and others that will be utilized during the 
course of the project.  You can enter data on forms; manage form records in a database, 
export information, print forms, among other functions. 
 
Although the program has numerous functions, many will not be necessary to fulfill the 
TSIP data entry needs.  Only the most essential will be discussed in this training guide.   
You are welcome to learn more for your personal use and enrichment.  For more detail 
on a particular function or activity, FormFiller has a comprehensive Help selection on 
the main toolbar. 
 
 
Data entry software – Installation: 
 
Each coalition will be provided a CD-ROM with the OmniForm Filler software to be 
installed at each of their study sites. 
 
Prior to installation, evaluators will log on to the TSIP web site:  www.txsip.org 
and download the Texas Strategies for Success (TSFS) master form.   
Upon downloading, TSFS master files should be located in a dedicated folder on the 
local computer’s hard drive for convenience. 
 
To install OmniForm Filler: 
 

1) Insert OmniForm Filler’s CD-ROM in the CD-ROM drive. 
  The setup program should start automatically.  If it does not start, locate 
     your CD-ROM drive in Windows Explorer and double-click the Setup.exe 
     program at the top-level of the CD-ROM. 
 
The first setup screen looks like the following: 
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2) Click Install OmniForm Filler 5.0 to start installation. 
 

3) Follow the installation instructions on each screen. 
  By default, OmniForm Filler files are installed in this folder location: 
  c:\program files\scansoft\omniform filler.   You can select a different 
      location if desired. 
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Starting OmniForm Filler: 
 
 
To start OmniForm Filler, do one of the following: 
 

 Click Start in the Windows taskbar and choose 
     Program > ScanSoft Omniform Filler 5.0 >  Omniform Filler 5.0 
 

 Double-click the OmniForm Filler icon on your desktop if a shortcut was 
created 

 
The OmniForm Filler desktop looks like this when you first open it: 
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To open a form for filling: 
 
 

1) Click the Open button or choose Open … in the File menu to open a form. 
The open dialog box appears: 

 
 

 

Select a Form to 
fill 

Select  
OmniForm Form  

 
 
 

2) Select OmniForm Form as file type 
3) Locate and select the desired form 
4) Click Open 
5) The form opens and is ready for you to create a new record.  
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After you open a form, more OmniForm tools appear 
on the desktop: 
 
 
 
 

 

Standard buttons 
appear for printing, 
resizing view, and 
other tasks 

Use these buttons to 
scroll through records 
in your database 

Use this button to 
highlight fillable 
fields 

 
 
 

Page navigation – 
Select page with 
mouse or Press 
Ctrl-Page Up or 
Ctrl-Page Down  
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Moving through fields on a form: 
 
There are several options for navigating through a form depending on personal 
preference.  For those who prefer the use of a mouse, due to its design, a form may be 
filled almost exclusively with the use of the mouse.   For those that prefer keyboard 
entry, there are key combinations for every function.  And there is also a combination of 
keyboard and mouse clicks.   
 
After opening a form, click in a field to place the cursor there and start entering the 
desired information or hit the Tab key. 
 
The following chart shows the most commonly used keyboard combinations to move 
the cursor within the form. 
 
 

Action Keyboard Combination 
Place the cursor in a 
field 

When a form first opens, press Tab to place the cursor in the 
first field 

Next field Press Tab 
Previous field Press Shift-Tab 
Next line in a fill 
text field 

Press Enter to move to the next line in a multiple line fill 
text field 

End of a line in a fill 
text field 

Press End 

Beginning of a line 
in a fill text field 

Press Home 

Open drop down list  Press Arrow Down 
Move through drop 
down list choices 

Press Arrow Up or Down 

Select a response on 
drop down list and 
move to the next 
field 

Press Tab 

Move across boxes 
in a check box field 

Press Arrow Up or Down 

Insert an X in a box  Press Space bar 
Erase an X in a box Press Space bar 
Move across pages Press Ctrl-Page Up or Ctrl-Page Down 
 
If you choose to Tab from field to field, OmniForm Filler will automatically go to the 
next page to get to a subsequent field.   
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The mouse may be used at any time to position the cursor in a field, display the choices 
in a drop down field, make a selection in a drop down list, or mark and erase a mark in a 
box.   
     
Upon completion of a form, to add a new record, click the right-most arrow of the page 
navigation arrows on the toolbar.  Note that the toolbar icon functions are displayed 
when the cursor is resting for a moment on an icon. 
 
All fields have some validation settings to assure data integrity, such as: 
 

• Required information to be entered so that the field is not left blank 
• Requiring specific information to be entered 
• Requiring information to be entered from a list of choices 

 
For example, you would be required to enter a valid Participant ID.  You will receive an 
error message from OmniForm if you attempt to enter an invalid number or leave it 
blank.  Depending on the type of validity check, the message may be displayed upon 
tabbing to the next field or when attempting to go to the next record. 
 
 
Database query and data editing: 
 
 
Every OmniForm form has its own OmniForm database associated with it.  The first 
time you open a form and fill out information, it becomes the first record in the 
database.  If a database has more than one record, you can use the Records buttons on 
the toolbar to navigate up and down the database or use the Go To commands in the 
Records menu.   
 
OmniForm can quickly search and retrieve records with the information that you need.  
Select the search feature under the Records menu and fill in the search criteria in the 
dialog box that appears.    
 
Any data field may be changed by merely locating the desired record, tabbing or 
clicking the mouse on the field to be changed and tabbing out of the form or selecting a 
new record.  
 
OmniForm automatically saves form records as you fill them out.  Saving occurs after 
various actions, such as moving from one record to another, printing or closing a form.   
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TSFS form printing: 
 
To print your form: 
 

1) Click the Print button or choose Print… in the File menu. 
 
 The Print dialog box appears: 
 

 
 

Select the records 
you want to print:
Current Record; 
All Records 

 
 
 

Select Form and 
Data; Data Only 
or Form Only 

 
 

2) Select the desired options for printing 
3) Click OK to start printing 

 
OmniForm prints your form with the selected settings. 
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Database saving and archiving: 
 
As mentioned earlier, all records entered into a form become records in an OmniForm 
database within the single OmniForm file that was initially selected for data entry.  This 
makes saving and archiving or backing up the database of participant data records easy.    
 
A current copy of the TSFS file should be maintained on a floppy diskette or RW-CD in 
the event of computer failure.  Another alternative would be to email the file to another 
authorized party within the coalition or to the TSIP data manager.  
 
 
Database transmission: 
 
Upon completion of all Texas Strategies for Success (TSFS) interviews, evaluators are 
to transmit the final file as an email attachment to the TSIP data manager at: 
 
  aistrategies@aol.com 
 
The email should clearly state that the file represents all the participant interviews and a 
record count of same.  AIS will confirm receipt of the file and immediately begin 
checking the data for completeness and consistency.  AIS will provide the site 
evaluators with the results of the data checking and provide an opportunity to correct 
any errors or to supply any missing data elements. 
 
Cumulative top line tabulation of each coalition’s database will be performed and 
available for download on the TSIP web site as well as their “clean” data file for their 
local use.   Coalition data will, of course, be combined to form a state-wide database for 
ultimate analysis and reporting. 
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Data Collection Help and Technical Assistance: 
     Contact 
 
For questions regarding form content or  
response categories ...........................................................  Dr. Tony Rey 
                  972-401-8800 
   treytx@treytx.com 
 
 
 
For all other technical assistance ........................................Adrian Reyes 
                            972-980-0227 
   AIStategies@aol.com 
 
 
NOTE:   Complete documentation of OmniForm Filler software functions is available 
               on the Help menu on the main toolbar.                      
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TSIP Identification Numbers 
  

 
The cross-site ID number has three components and is displayed as follows: 

 
        A                B                       C                       

|___|___| b |___|___|___| b |___|___|___|___| 
    |  |                       |                          

         |                        |                       |_____ Participant Identifier (9999) 
              |             |                Numbers can range from 1 to 9999. 

                   |             |                       It is not necessary to use all four    
|  |   digits. 

           |             |                  
        |             |                   

         |  |______ Study Site Identifier (999) 
       |   A number assigned by the TSIP evaluation team to 

   |  the study site within a coalition.  Each study sites 
   |   identifier is a constant. 

  | 
  | 
  |______ Coalition Identifier (99) 
    TCADA Program ID  
  
   

For example, a study subject might have the following ID number: 
 

26-001-0114 
 
 The number tells us that this study subject is number 114 at site #1 of coalition #26  
 
Individual Identifiers.  The last four-digit number of the ID number is the individual identifier.  These 
numbers will be assigned by the study site.  They should be numeric values (not alphanumeric).  
Programs with multiple service locations may want to consider assigning a range of individual identifiers 
to each location to allow for easy identification of a participant’s service location.  For example, one 
location could be assigned numbers 1000 to 1999, numbers 2000 to 3999 to a second location, and so 
forth.  It is not necessary to use all five digits.  It is necessary that each study subject be assigned a unique 
individual number within the range of 1 to 9999. 
 
Each of the three components in the ID number must be a separate numeric variable in data files 
submitted to the TSIP evaluation team.   
 
Treating each component of the ID number as a numeric variable will allow the TSIP evaluation team 
to efficiently organize data according to region, coalition and study site. Using numeric variables will also 
facilitate efficient data processing and tracking. 
 
The TSIP evaluation team will append the TCADA region code to the database.
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TCADA  Regions 
 
 
 
 
 

 
 

 
 

Region 1  -- Panhandle (Amarillo, Lubbock and Surrounding Counties) 
Region 2  -- Northwest Texas (Abilene, Wichita Falls and Surrounding Counties 
Region 3  -- North Central Texas (Dallas-Fort Worth and Surrounding Counties 
Region 4  -- Northeast Texas (Tyler, Texarkana and Surrounding Counties) 
Region 5  -- Upper Gulf Coast (Nacogdoches, Beaumont and Surrounding Counties) 
Region 6  -- Central Gulf Coast (Houston and Surrounding Counties) 
Region 7  -- Central Texas (Austin, College Station and Surrounding Counties) 
Region 8  --  South Central Texas (San Antonio, Uvalde and Surrounding Counties 
Region 9  -- Permian Basin (Midland/Odessa, San Angelo and Surrounding Counties) 
Region 10 --  Far West Texas (El Paso and Surrounding Counties) 
Region 11 -- South Texas (Rio Grande Valley and Lower Gulf Coast)  
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